
 
 

 

Outlook Web Access (OWA) Usage Guide 

About 
Updated 10/31/23. 

Outlook Web App (OWA), also known as OWA or Outlook on the web, is a full-
featured, web-based email client with the look and feel of the Outlook desktop 
client.   

To check your email using Outlook Web Access, open a web browser and go to 
https://outlook.office.com and login with your Single Sign-On (SSO) Credentials. 
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Login to OWA 

To access Outlook Web Access (OWA), open a web browser and go to 
https://outlook.office.com and login with your Single Sign-On Credentials. 

  

You can also login to Self-Service, select the Navigation Menu, select 
Employment, and select the link to Check My Email (Office365), which will take 
you to the same website. 

 

Multi-Factor Authentication (MFA) Required for Offsite Access 

Note that Multi-Factor Authentication (MFA) is a requirement if you are accessing 
Outlook Web Access while outside of the campus network. If you need help with 
multi-factor authentication, see our Multi-Factor Authentication (MFA) FAQs. 

https://outlook.office.com/
https://colss-prod.cloud.rsccd.edu/
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Multi-Factor-Authentication-(MFA)---Frequently-Asked-Questions-(FAQs).aspx


 
 

 
 

OWA Interface 

Below is a quick overview of the OWA interface. 

1. Navigation Pane 
2. Ribbon Toolbar 
3. Inbox (Focused Mode / Other) 
4. Reading Pane 
5. Search bar 
6. Other Options 

 

1. Navigation Pane 

The Navigation Pane contains links to your Folders. 

The default folders include the Inbox, Drafts, Sent Items, Deleted Items, Junk 
Email, Archive, as well as other custom folders you’ve created. 

There are also icons for your Calendar, People (Contacts), and Task lists.   

See Microsoft’s guidance on What is the Navigation Pane? and Working with 
message folders in Outlook on the web. 

https://support.microsoft.com/en-us/office/what-is-the-navigation-pane-24fcad76-7604-4ab0-80ed-18d65fcc9dc3
https://support.microsoft.com/en-us/office/working-with-message-folders-in-outlook-on-the-web-ae0f10d6-54e7-4f29-acd3-78cdc3fdcb9f
https://support.microsoft.com/en-us/office/working-with-message-folders-in-outlook-on-the-web-ae0f10d6-54e7-4f29-acd3-78cdc3fdcb9f


 
 

 
 

 

2. Ribbon Toolbar 

The Ribbon Toolbar contains quick options to create a New Mail, Reply or 
Forward Email, and other actions. 

 

3. Inbox (Focused Mode / Other) 

The Inbox lists all your emails.  By default, the Inbox is categorized between 
“Focused” and “Other”.  



 
 

 
 

 

The “Focused” inbox attempts to sort the most important emails for you, and 
places everything else into the “Other” tab. 

To turn off “Focused” mode, see How do I turn off Focus Mode in Outlook? 

4. Reading Pane 

The reading pane displays the contents of a message you’ve selected.  You can 
also double-click a message to open it in a separate window. 

https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#focus-mode-off


 
 

 
 

 

5. Search bar 

The Search bar allows you to do a search of the mailbox.  

For detailed guidance on how to use the Search bar, see Microsoft’s article on 
Search Mail and People in Outlook on the web. 

 

6. Other Options 

On the top right of OWA, you can find other options such as the menus for 
Settings and Account Manager (where you can sign out or sign into a different 
Microsoft account). 

See Microsoft’s guidance for Mail settings and Easy Account Switching With 
Account Manager. 

 

https://support.microsoft.com/en-us/office/search-mail-and-people-in-outlook-on-the-web-b27e5eb7-3255-4c61-bf16-1c6a16bc2e6b
https://support.microsoft.com/en-us/office/mail-settings-30c69a79-efc6-42d2-b740-4bf1c1f8a01c
https://insider.microsoft365.com/en-us/blog/easy-account-switching-with-account-manager
https://insider.microsoft365.com/en-us/blog/easy-account-switching-with-account-manager


 
 

 
 

Mail Basics 

Create a new email 

To create a new email: 

1. Select New Mail. 

 

This will open a blank new email in the Reading Pane.    

Add a recipient’s email address to the To field and use the Add a Subject and 
Body fields to type an email.   

When you are ready to send the email, select Send. 

 

  



 
 

 
 

Reply to an email 

To reply to an email: 

1. Select the message from the Inbox. 
2. Select the Reply button. 

This will open a new blank email in the Reading Pane in reply to the original email.   

This will also append a Re: to the subject line of the email. 

 

Reply All to an email 

To “reply to all” recipients on an email: 

1. Select the message from the Inbox. 
2. Select the Reply All button. 

This will open a new blank email in the Reading Pane in reply to the original email, 
including the original recipient and the others CCed on the email.   

This will also append a Re: to the subject line of the email. 

 



 
 

 
 

Forward an email 

To forward an email: 

1. Select the message from the Inbox. 
2. Select the Forward button. 

 

This will open a new blank email in the Reading Pane where you can specify new 
recipients in the To, Cc, and Bcc lines, and which starts a new email conversation 
outside of the replies to the original message.   

This will also append a Fw: to the subject line of the email. 

Enable From, CC (Carbon Copy), and Show Bcc (Blind carbon copy) fields 

By default, OWA shows the To, Subject, and Body fields in new emails. 

To enable additional fields for From, Bcc, and Cc: 

1. Select the Options tab. 
2. Select the checkboxes for Show Bcc, Show Cc, and Show From. 
3. These fields will now appear when creating new emails or 

replying/forwarding email. 

NOTE on Cc (Carbon copy) and Bcc (Blind carbon copy):   

“Cc” refers to carbon copy, and “Bcc” refers to blind carbon copy.    

Cc (carbon copy) allows you to send a copy of an email to someone apart from 
the recipient in the To field. 



 
 

 
 

Bcc (blind carbon copy) is like Cc, except that the email addresses of the 
recipients in this field do not appear in the received message header, and the 
recipients in the To or Cc fields will not know that a copy was sent to these 
recipients. 

 

For further guidance, see Microsoft’s article Show, hide, and view the Bcc (blind 
carbon copy) field. 

Create an email signature 

To manage your email signatures: 

1. Select the Settings icon (on the top right of OWA). 
2. Select Mail. 
3. Select Compose and reply. 

From here you can create a New Signature or manage existing signatures. 

You can also configure default signatures for New Messages and for 
Replies/Forwards. 

https://support.microsoft.com/en-us/office/show-hide-and-view-the-bcc-blind-carbon-copy-field-04304e27-63a2-4276-8884-5077fba0e229
https://support.microsoft.com/en-us/office/show-hide-and-view-the-bcc-blind-carbon-copy-field-04304e27-63a2-4276-8884-5077fba0e229


 
 

 
 

 

For further guidance, see Microsoft’s article Create and add an email signature in 
Outlook.com or Outlook on the web 

Set an out of office message (Automatic replies) 

To set an out of office message (Automatic Reply): 

1. Select the Settings icon (on the top right of OWA). 
2. Select Mail. 
3. Select Automatic replies. 
4. Select Turn on automatic replies.  

https://support.microsoft.com/en-us/office/create-and-add-an-email-signature-in-outlook-com-or-outlook-on-the-web-776d9006-abdf-444e-b5b7-a61821dff034
https://support.microsoft.com/en-us/office/create-and-add-an-email-signature-in-outlook-com-or-outlook-on-the-web-776d9006-abdf-444e-b5b7-a61821dff034


 
 

 
 

 

Options for automatic replies include:  

1. Sending replies only during a specific period, with start and end time. 
2. Sending a separate reply for recipients outside of your organization. 
3. The ability to block your calendar and decline new invitations that occur 

during the time set for your out of office reply. 

When done, select Save. 

NOTE:  If you did not specify a Start and End Time for your automatic replies, they 
will stay on indefinitely until you toggle the Automatic replies off. 

Inbox Management basics 

Focused Inbox and Other 

By default, the Inbox is categorized between “Focused” and “Other”.  

The “Focused” inbox attempts to sort the most important emails for you, and 
places everything else into the “Other” tab. 

To turn Focus Mode on or off: 

1. Select the View tab. 
2. Select View settings. 



 
 

 
 

3. Select Mail. 
4. Select Layout. 
5. Under Focused Inbox, select “Sort messages into Focused and Other” or 

“Don’t sort my messages.” 

 

View Emails as Conversations, or Show Each message separately 

By default, OWA will organize your Inbox emails as Conversations.  A 
conversation includes all messages in the same thread with the same subject line. 

To toggle Conversations on or off: 

1. Select the View tab 
2. Select Messages. 
3. Select Conversations 
4. Select “Group into conversations” or “Show each message separately”. 

 



 
 

 
 

Add a shared mailbox 

To add a shared mailbox to OWA: 

1. From the Navigation Pane, right click Folders. 
2. Select Add shared Folder or mailbox. 
3. In the search box, enter the email address of the shared mailbox (e.g., 

sharedmailbox@sac.edu) 
4. Select Add. 

 

The shared mailbox will now appear in the Navigation Pane. 

Note on Full Access permissions to shared mailboxes: 

You will need Full Access permissions to the shared mailbox to add it to Outlook. 

If you need to request access permissions, please create a ticket with the ITS Help 
Desk at helpdesk@rsccd.edu or 714-564-4357 Ext 0 so we can help. 

Send emails from a shared mailbox 

To send emails as a shared mailbox: 

1. Follow the steps to add a shared mailbox to OWA. 
2. Enable the From field  under View settings. 

mailto:sharedmailbox@sac.edu
mailto:helpdesk@rsccd.edu


 
 

 
 

3. Create a new email. 
4. In the new email, select the dropdown menu from the From field, and 

select Other email address.  
5. Manually type in the email address of the shared mailbox or use the Search 

Directory feature to look up the shared mailbox in the directory. 

  

Note on Send As permissions to shared mailboxes: 

You will need Send As permissions the shared mailbox to send emails from it. 

If you need to request access permissions, please create a ticket with the ITS Help 
Desk at helpdesk@rsccd.edu or 714-564-4357 Ext 0 so we can help. 

Calendar Basics 

Accessing the Calendar 

To access your Calendars: 

1. Select the Calendar icon from the Navigation Menu. 

 

mailto:helpdesk@rsccd.edu


 
 

 
 

Adjust calendar views (Day, Work Week, Week, Month) 

To toggle the calendar views: 

1. From the Ribbon Bar, select Day, Work week, Week, or Month views. 

 

For example, selecting the Month view will display the entire month of events. 

 



 
 

 
 

Create new calendar events 

To create a new calendar event: 

1. Select a date on the calendar, then select New Event. 
2. Configure the appointment with a title, attendees, start and end time, and 

a description. 
3. When done, select Save. 

 

View multiple calendars 

To view multiple calendars at once: 

1. Use the navigation and select multiple calendars using the button icons. 
2. Multiple calendars events will appear in different colors on the display. 

For example, selecting your own calendar and a shared calendar will display 
events for both calendars at the same time in different colors (e.g., green and 
orange). 



 
 

 
 

 

Add calendars from Directory 

To add new calendars: 

1. On the calendar navigation menu, select Add Calendar. 
2. Select Add from Directory 
3. Select an account to search from 
4. Enter a name or email address for the associated calendar (e.g., OEC 

Absence Calendar) 
5. Select where the calendar should Add to (e.g., My calendars, Other 

calendars, People’s calendars) 
6. Select Add when finished. 

The calendar you added will then appear as an additional menu item in the 
calendar navigation menu. 



 
 

 
 

 

Add calendars outside of Directory 

For guidance on how to add additional calendars outside of the directory, such as 
personal calendars or uploading calendars from a file, see Microsoft’s 
documentation on Add a calendar in Outlook.com or Outlook on the web. 

Sharing your personal calendar with others 

To share your personal calendar with others: 

1. Find your Calendar under My calendars. 
2. Right click on the Calendar and select Sharing and permissions. 
3. Enter an email address or contact name for the person you want to share 

your calendar with. 
4. Select the appropriate permission level for that person. 

a. List of permissions (from least to most permissive): 
i. Can view when I’m busy 

ii. Can view titles and locations 
iii. Can view all details 
iv. Can edit 
v. Delegate (Full Access) 

5. When done, select Share. 

You can also return to the Sharing and Permissions screen to alter or remove 
calendar permissions from those you’ve already shared with. 

https://support.microsoft.com/en-us/office/add-a-calendar-in-outlook-com-or-outlook-on-the-web-6641b635-2797-42ce-a500-597eaef0fd19


 
 

 
 

 

NOTE:  Shared mailbox calendars and public calendars have a different set of 
permissions that are managed by ITS.   

If you need access to a shared calendar or public calendar and aren’t able to see it 
in the Directory, please contact the ITS Help Desk so we can verify if this requires 
access permissions to be granted by your supervisor or the owner of the mailbox. 

NOTE:  Other people’s personal calendars have their own access permissions.  If 
someone hasn’t shared their calendar with you, you may not be able to see any 
contents.  You’ll need to ask that person to give you permission to their calendar 
as described above. 

Create new calendar events 

To create a new calendar event: 

1. Select a date on the calendar, then select New Event. 
2. Configure the appointment with a title, attendees, start and end time, and 

a description. 
3. When done, select Save. 



 
 

 
 

 

Contacts Basics 

How to use Contacts 

See Microsoft’s article on Using contacts (People) in Outlook on the web. 

Modifying Contacts 

See Microsoft’s article on how to Create, view and edit contacts and contact lists 
in Outlook. 

Other Resources 

Microsoft Outlook for iOS and Android (Mobile App) 

To access email from a mobile device, see our Microsoft Outlook for iOS and 
Android Mobile App Guide. 

ProofPoint Spam Quarantine 

If you need help with emails being quarantined as spam or junk, see our 
ProofPoint Spam Quarantine FAQs. 

https://support.microsoft.com/en-us/office/using-contacts-people-in-outlook-on-the-web-1e3438c7-26b2-420c-87de-3cea9d31b5cb
https://support.microsoft.com/en-us/office/create-view-and-edit-contacts-and-contact-lists-in-outlook-ca469928-4b1c-47e4-ae85-15b6345ce043
https://support.microsoft.com/en-us/office/create-view-and-edit-contacts-and-contact-lists-in-outlook-ca469928-4b1c-47e4-ae85-15b6345ce043
https://rsccd.edu/Departments/Information-Technology-Services/Documents/End%20User%20Training/Microsoft-Outlook-for-Android-and-iOS-Mobile-App-Guide.pdf
https://rsccd.edu/Departments/Information-Technology-Services/Documents/End%20User%20Training/Microsoft-Outlook-for-Android-and-iOS-Mobile-App-Guide.pdf
https://rsccd.edu/Departments/Information-Technology-Services/Pages/ProofPoint-Spam-FAQs.aspx


 
 

 
 

Multi-Factor Authentication (MFA) 

If you need help with multi-factor authentication, see our Multi-Factor 
Authentication (MFA) FAQs. 

Single Sign-on (SSO) 

If you need help with Single sign-on, see our Single Sign-on (SSO) FAQs. 

Password Troubleshooting 

If you need help with your password, see our Password Troubleshooting FAQs. 

OWA Frequently Asked Questions (FAQs) 

Exchange Online Migration FAQs 

See our other Frequently Asked Questions (FAQs) from the Exchange Online 
Migration FAQs. 

• When I go to outlook.office.com, I am already signed in with an existing 
Microsoft account from another institution / another company. 

• I can't access email at mail.rsccd.edu. I get a "something went wrong" 
message. 

• I can't access email from outlook.office.com. I get a "something went 
wrong" message 

• I was advised to use outlook.office.com as a temporary workaround, but 
need to open a shared mailbox. How do I do this? 

• My contacts and address list are not loading in Outlook after the migration. 
How do I fix this? 

• I am receiving an error when trying to send emails from a shared 
mailbox.  The error is "You do not have permission to send the message on 
behalf of the specified user." 

• When sending emails to a specific person, I'm getting an error that says, 
"Your message couldn't be delivered."  How do I fix this? 

• How do I turn off Focus Mode in Outlook? 
• Copy and Paste no longer works from Outlook Web App.  How do I fix this? 
• I lost my email signatures.  How do I re-create them? 

https://rsccd.edu/Departments/Information-Technology-Services/Pages/Multi-Factor-Authentication-(MFA)---Frequently-Asked-Questions-(FAQs).aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Multi-Factor-Authentication-(MFA)---Frequently-Asked-Questions-(FAQs).aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Single-Sign-On-FAQs.aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Single-Sign-On-Password-Troubleshooting.aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#sign-in-with-a-different-account
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#sign-in-with-a-different-account
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#something-went-wrong
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#something-went-wrong
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#legacy-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#legacy-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#open-shared-mailbox
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#open-shared-mailbox
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#contact-list-update
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#contact-list-update
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#send-on-behalf-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#send-on-behalf-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#send-on-behalf-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#delete-auto-complete
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#delete-auto-complete
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#focus-mode-off
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-MIgration-FAQs.aspx#copy-paste-owa
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#signatures


 
 

 
 

• Why am I getting an error when trying to send emails with .DOCM files 
attached? 

Troubleshooting problems 

Troubleshooting sign-in problems 

• Use the Password Reset page if you’ve forgotten your password, or need to 
retrieve your username. 

• Use the Change Password page to create a new password. 
• Read the Single Sign-On FAQs page for other sign in issues. 

Contact the ITS Help Desk 

• Website:  https://webhelpdesk.rsccd.edu 
• Phone:  714-564-4357 Extension 0 
• Email:  helpdesk@rsccd.edu  

(Select this link to return to the beginning of the document) 

https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#docm-error
https://rsccd.edu/Departments/Information-Technology-Services/Pages/Exchange-Online-Migration-FAQs.aspx#docm-error
http://www.rsccd.edu/resetpassword
https://rsccd.edu/changepassword
http://www.rsccd.edu/sso
https://webhelpdesk.rsccd.edu/
mailto:helpdesk@rsccd.edu
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